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Introduction
CONGRATULATIONS! By purchasing the SmartBox® system, you have obtained the world’s first
variable-rate, speed-compensated, and totally enclosed system for the application of low-rate
granular insecticides. The SmartBox® system was created to allow granular insecticides to be
applied accurately, efficiently, and safely to your crops.
The information presented in this Parts & Operator’s Manual will introduce you to the components
of the SmartBox® system, provide step-by-step instructions on how to install the system on your
planter, and lead you through the programming and operating steps required to obtain the most
accurate application and record keeping possible. Please read all of the information in Section A
before proceeding to Sections B, C, & D. Section A will tell you the tools needed for installation and
operation, as well as give you helpful hints to make installing the system as effortless as possible.
From all of the employees at AMVAC Chemical Corporation who have worked to offer you the
SmartBox® system, we are confident that you will enjoy the many benefits of our product. Should
you have any questions or comments, please feel free to contact your local AMVAC sales representative or call our Customer Service Center at 1-888-SMARTBOX (1-888-762-7826). Or,
you may write to us at the following address:
AMVAC Chemical Corporation
Attn: SmartBox® Customer Services
2110 Davie Avenue
Commerce, CA 90040
www.amvac-chemical.com or www.smartboxsystem.com
SmartBox® is a registered trademark of AMVAC Chemical Corp.
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NOTICE — SAFETY PRECAUTIONS
Persons using a SmartBox® system to apply granular insecticides are responsible for
obtaining, reading, and following all safety recommendations as stated on the
manufacturer’s product label. Read and follow all use directions and precautions
specified on the product label(s), including, but not limited to, the following sections:
• Emergency Response Telephone Numbers
• Personal Protective Equipment (PPE)
• User Safety Requirements
• User Safety Recommendations
• Environmental Hazards
• Directions for Use
• Agricultural Use Requirements
• Storage and Disposal
In addition, all SmartBox® system maintenance must be performed in compliance with
product safety precautions as stated on the product label. If you have questions
regarding any of the use directions and precautions specified on the product label, or
require additional information, contact your local AMVAC sales representative or
call 1-888-462-6822. You may also visit the AMVAC Chemical Corporation website at
www.amvac-chemical.com for access to product labels and other information.

NOTICE — WARRANTY
All parts and assemblies supplied with the SmartBox® application system are intended
for use only with this system and only with the insecticide products licensed for
application using this system. Any usage of the SmartBox® system which is inconsistent
with the intended usage will result in the following actions:
• The entire warranty for the SmartBox® system will be voided immediately.
• User will be in violation of U.S. Patent laws and will be prosecuted to the
fullest extent of the law.
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System Overview
System Description:
The AMVAC SmartBox® system is a closed transfer application system which uses electronically controlled metering technology to accurately apply low-rate granular insecticides. The system
features a controller which can store and record the necessary information required by the
Environmental Protection Agency (EPA) for record keeping.
The controller can easily download the stored information to a personal computer at the user’s
convenience. This transfer of information is performed by connecting the controller to the personal computer. Windows-based record-keeping software is also included with the system.
An added feature of the SmartBox® system is the ability to program controller functions by entering information into the personal computer. That information can then be transferred from the
personal computer to the controller.
An additional option is GPS capability. The SmartBox system can connect to an external GPS
controller for mapping and/or variable rate application.
The SmartBox® system provides the operator with on-the-go flexibility to monitor and change various operating parameters or set the system and allow it to run automatically. The controller,
which mounts inside the tractor cab, enables the user to quickly change the chemical application
rate or shut off flow to one, all, or any combination of planter rows.
Input from a lift switch mounted on the planter will shut the system off when the planter is raised.
Audio and visual alarms on the controller alert the user of a possible plugged row tube, non-flowing meter, or empty chemical box by row.
The accuracy of the SmartBox® system is optimized if true ground speed is measured using
radar or another true wheel speed measurement device. With accurate speed input and proper
calibration, the meters will automatically compensate for variations in planter speed to keep the
chemical application rate steady. If true ground speed is not available, a fixed planting speed can
be entered but application accuracy will depend on how closely actual ground speed matches
fixed speed entered in controller.
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What’s Included:
The AMVAC SmartBox® system consists of the components listed below. All components will be
received in the quantities required for your planter according to the manufacturer, row count, and
fold type of the planter.
Controller: The controller is the central control of the SmartBox® system. It is installed in the tractor cab and connects to the 12-volt electrical system of the tractor. All mounting hardware is
included.
SmartBox® System Manager: The software is Windows-based. Information such as Grower ID
and Applicator License Number can be added for record-keeping.
Meter: The meter is attached to the base container and includes both the metering device and a
flow sensor. Once the meters are configured, the controller is able to identify the exact meter and
row number if a problem occurs. A 24” discharge tube (a 30” braided nylon tube may be purchased if needed), and tube clamp are included with each meter.
Wiring Cables: These cables include the hitch cable, hitch extension cable (if required), 8-row
and / or 4-row wiring harnesses, and meter extension cables (if required) used to make the electrical connection between the controller and the meters. Also included as needed are the battery
extension cable and lift switch extension cable.
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Lift Switch: The mechanical lift switch with cable is used to signal the controller that the planter
is either in the raised or lowered position. This input tells the controller when to start and stop the
meters to avoid discharge of chemical on row turns. The lift switch is connected to the system
through the 4-row or 8-row wire harness.
Base Container: The base container will hold a range of 8 to 15 pounds of chemical. Each base
container comes with a rain cover for use when a transfer container is not installed.
Universal Mounting Cradle: The universal mounting cradle is designed to fit onto most of the
major planter row configurations to hold the base container and meter securely on the row frame.
Mounting hardware (with clips and brackets for various planter manufacturers and series) is
included.
Transfer Container: The transfer containers are available only through a Chemical Dealer. The
boxes will be delivered with product loaded and ready for use. With a transfer container locked
in place on the base container and with valves opened, product will flow to fill the base container for discharge through the meter and discharge tube. A loaded transfer container can be dispersed into many base containers, so a new transfer container may not be needed every time a
base container empties. This feature is handy when finishing a field or at the end of the planting
season.
The controller, lift switch, battery cable, hitch cable, and software are part of the Controller
System. The transfer container, base container, cradle, and meter with discharge tubing make
up the SmartBox® Row Unit. These will be discussed in greater detail later in the manual.
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What’s Not Included:
The following items are not included with the AMVAC SmartBox® system. If any of these items
are required for installation and operation of the SmartBox® system on your planter, please contact your chosen Equipment Dealer or the appropriate source shown below to purchase the
item(s) separately. These items will not be part of the SmartBox® system shipped to you from
AMVAC.
Radar or true wheel speed sensor: Input to the controller from radar or a true wheel sensor is
required to get the most accurate chemical application rate. The system is operable in a fixed
speed mode, but automatic speed compensation will not be available in this mode.
The SmartBox® controller has a 4-pin radar connector compatible with the connector of many
leading radar brands. Other radar and true-wheel sensors (some true wheel speed sensors are
not compatible) may be used; if your sensor has a different connector arrangement, an adapter
will be required and must be purchased separately. Radar signals routed through tractor wiring
must match the pin assignments of the controller; some systems have been found to feed voltage to the controller through a signal pin resulting in a “buzzing” of the controller when the controller is shut off. While this arrangement does not damage the controller, the radar signal may
not be read correctly. There is a cable available to filter the voltage feed. Contact your local
AMVAC representative for further information.
Radar or true wheel speed sensor Y-cable or signal booster: When using radar to more than one
monitor (planter monitor and SmartBox®), a Y-cable will be required. If the sensor’s signal will be
split for several monitors, then a signal booster may be required. For help with the requirements
of your setup, including compatibility of specific true wheel sensors and radar wiring arrangements, we can suggest these sources:
AG-EXPRESS Electronics Des Moines, IA 515-289-2746
Sulphur Springs, IN 765-533-4809
Grand Island, NE 308-381-2905
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White planter series 6000 & 8000 seal lid kits or seed hopper extension rings: When installing
the SmartBox® system on a White series 6000 planter, seal lid kits or seed hopper extension
rings may be required. These planters use seed boxes with lids designed to slide backward over
the insecticide hopper for filling. The SmartBox® transfer containers will extend approximately
two inches above the seed box lids, preventing the lids from sliding backward. If liquid fertilizer
tanks are installed in front of the seed boxes, the tanks may prevent the seed box lids from sliding forward. In this situation, either the seed box lids may be replaced with hinged lids (White’s
seal lid kit), or the seed boxes must be lifted with spacer rings. Contact your local White
Equipment Dealer or your AMVAC sales representative for recommendations.
In-furrow kits and discharge tubes: Recommendations on product application (in-furrow vs. Tband) must come from your Chemical Dealer or AMVAC. Discharge tubes currently are supplied
in 30” lengths and should be cut to fit the specific planter. L-brackets should be used on John
Deere, Kinze, White, and Buffalo planters to position the discharge tube. Attention should be
given to planters using seed firmers to verify the discharge tubes are not hitting the firmers while
the planter is in the down position. In-furrow kits and different diameter or length tubing must be
obtained from a source other than AMVAC.
Case IH row unit brackets: When installing the SmartBox® system on a Case IH planter which
has not previously used insecticide boxes, any additional row unit frames or brackets may
be purchased through an Equipment Dealer. Rear mount brackets for the Case 1200 Series
planters may be purchased through Redball, LLC. Contact Redball, LLC at 1-877-332-2551 for
pricing and bracket options.
John Deere 1770NT, 1790, and DB model planters: Brackets have been developed to mount the
SmartBox® on these model planters. Contact Redball, LLC at 1-877-332-2551 for pricing and
bracket options.
In addition, as new planter designs and folds are introduced to the market, some modifications
may be required. If you have any questions concerning compatibility of the SmartBox® system
with your particular planter configuration, you may contact your AMVAC Sales Representative
(1-888-SMARTBOX) for answers to your questions.
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How To Get Started

Tools Required:
The following tools will be required to install your SmartBox® system:
cordless drill
7/16” wrenches
7/16” sockets
pliers

drill bits
3/8” socket bit
nut driver
3/8” wrench

Additional tools may be required for lift switch and controller mounting.

Time Required:
The amount of time required to install your system will depend on your planter
design, fold type, and number of rows. Also, the amount of information you enter
into the controller will have an affect on installation time. The following chart
presents estimated time requirements.
number of planter rows
4
8
12
16
24

hours required
4-6
6-8
8 - 10
10 - 12
12 - 14
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Installation

This section will include instructions on installation of the SmartBox® controller system, row units,
and wiring cables. Suggested cable routings and lift switch mounting locations will be shown at
the end of this section (Appendix A). The order in which you install your system components may
vary from the order shown in this manual. These instructions are grouped by system. One recommended installation sequence is as follows:
1.
2.
3.
4.
5.
6.
7.
8.
9.

Remove existing insecticide boxes and chains. (If necessary)
Install cradles.
Install meters onto base containers.
Install base containers in cradles.
Loosely route all wiring and harnesses. Do not use cable ties at this point.
Adjust wiring and use ties to secure.
Install controller in tractor.
Install battery cable.
Install lift switch.

Due to the vast number of existing planter configurations and continuous introduction of new
ones, your planter may differ slightly from the figures shown here. If you have questions concerning fit of the SmartBox® system on your planter, please contact your AMVAC sales representative or call 1-888-SMARTBOX.
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Controller System:
The front and back of the SmartBox® controller are shown in Figures 1 and 2 below. The controller should be installed inside the tractor cab (or mounted on the tractor if there is no cab) in
a position where the user can easily see the screen during operation and where there is no possibility of the controller being damaged. When a 2-way FM radio is installed in the tractor cab,
care should be taken to position the controller to avoid potential interference. Also, sufficient
room must be provided behind the controller to connect the necessary cables (see Figure 2).

Screen
Display

Arrow
Keys

System On/Off
Button
Meter On/Off
Switch
Figure 1 - Controller Face

To Battery Cable
2-Pin Connector

Next
Page

To Radar Cable
4-Pin Connector

To Hitch Cable
9-Pin Connector
To Serial Port /
9-Pin Connector

Previous
Page

Radar Pin Assignments
1 - Ground
2 - Signal
3 - +12 Volt
4 - Empty

Figure 2
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Controller System (continued)
WARNING!
•
•

Only connect the SmartBox® Controller to the 12-volt battery of the tractor
Secure machinery from sudden or unwanted movement when working on or
near it. Remove key from the tractor ignition to prevent unwanted starting.

Suggestion: Before mounting the controller, estimate the length of cable required to run
between the controller and the connecting wiring harness. Each SmartBox® system
includes one 12’ hitch cable plus enough 12’ or 20’ extension cables for the planter indicated on the order. Locate the controller in a position which will not require additional
extension cables.
1. Secure the controller mounting bracket to the tractor using the three screws provided.
2. Use the two controller knobs to secure the controller to the mounting bracket.
3. Connect the controller’s power socket to the 12’ battery cable provided. An additional 12’
battery cable extension is available if needed.
Connect the battery cable terminals directly to the 12-volt battery with red wire to positive and
black wire to negative.
If the tractor is powered by two 6-volt batteries instead of one 12-volt battery, then the terminals
must be connected at a location where a 12-volt supply is available. The controller will not operate if sufficient power is not supplied.

To Controller
Red or White (Pos.)

Black (Neg.)

24-Volt System Using
Two 12-Volt Batteries

To Controller
Red or
To Controller
White (Pos.)
Red or White (Pos.)

Black (Neg.)

One 12-Volt Battery
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Controller System (continued)
Do not use a fuse greater than 30 amps in the supply; use of a larger amperage fuse
may result in controller damage.
Do not remove the fuse when attaching power port adapter. Be sure to check
polarity with positive to fuse.
Once the cables are routed and a speed sensor (if used) has been installed, connect the hitch
cable and speed sensor cable to the controller. If the speed sensor’s connector is not compatible with the controller’s 4-pin radar connector, then an adapter must be obtained by the user.
The 9-pin parallel port extending from the controller will not be used during planting. This port is
provided for transfer of data from the controller to a personal computer.
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Row Units:
The SmartBox® row unit is made up of the cradle, base container with rain cover, meter with
discharge tube, and transfer container. The transfer container is shipped from the insecticide
supplier and is not part of the system shipped. Installation of each of these items is shown below.
Cradle installation will differ according to the make and model of the planter. Existing insecticide
hoppers and drive chains should be removed prior to installation of the SmartBox® cradles.
Instructions for cradle installation on each of the major planter groups are shown beside Figures
3 through 8. General precautions for all planter types are as follows:
1. Use hardened steel for mounting pins.
2. Do not over-tighten. Doing so will cause the cradle sides to bend inward.
3. Check for clearance between hoppers on vertical fold planters. Insecticide transfer
containers may need to be removed for transport on vertical fold planters.
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Installation: Cradle - John Deere Planter Series 7000 and 7100

Figure 3

1. Remove existing insecticide hoppers
and drive mechanisms.
2. Orient SmartBox® cradle as shown in
Figure 3.
3. Position cradle so that legs of cradle slide
back into rear cross brace of row unit
frame.
4. Position cradle so that vertical posts on
row unit frame come through slots in cradle.
5. Place existing cotter pins through hole in
frame posts to lock cradle in place.
6. If cotter pins do not hold cradle securely in
place, use SmartBox® cradle clips as a
spacer between the frame and pins; or
secure the cradle to the frame using the
SmartBox® cradle clips and fasteners as
shown in Figure 3a.

Figure 3a

Installation: Cradle - John Deere Planter Series 1700, 7200 and 7300
1. Remove existing insecticide hoppers and
drive mechanisms.
2. Orient SmartBox® cradle as shown in
Figure 4.
3. Place the 5/16” x 1-1/2” bolt with washer
through the rear hole in the cradle in line
with the rear hole in the row unit frame
(as shown), lightly secure with washer and
lock nut.
4. Place the 5/16” x 1-1/2” bolt with washer
through the cross frame (as shown) and
lightly secure with washer and lock nut.
5. Center cradle in relation to planter frame
and tighten all bolts securely.
Figure 4
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Installation: Cradle - Kinze and Buffalo Planters
1. Remove existing insecticide hoppers
and drive mechanisms.
2. Orient SmartBox® cradle as shown in
Figure 5.
3. Position cradle so that legs of cradle
slide back into rear cross brace of row
unit frame.
4. Position cradle so that vertical posts on
row unit frame come through slots in
cradle.
5. Place existing cotter pins through hole in
frame posts to lock cradle in place.
6. If cotter pins do not hold cradle securely
in place, use SmartBox® cradle clips as
a spacer between the frame and pins; or
secure the cradle to the frame using the
SmartBox® cradle clips and fasteners as
shown in Figure 5a.

Figure 5

Figure 5a

Installation: Cradle - Great Plains Planter
1. Remove existing insecticide hoppers
and drive mechanisms.
2. Orient SmartBox® cradle as shown in
Figure 6.
3. Place 5/16” x 1-1/2” bolt with washer
through rear hole of the cradle down
through spacer and slotted mounting clip
(oriented as shown to catch underside of
planter frame) and secure with lock nut.
4. Place 5/16” x 1-1/2” bolt with washer
through slotted hole of the cradle down
through SmartBox® cradle mounting clip
(oriented as shown to catch underside of
planter frame) and secure with lock nut.
Figure 6

13
Section A

SmartBox® System - System Installation
Section A

Installation: Cradle - Case IH Planter Models 800 - 950 and White Series 5000
1. Remove existing insecticide hoppers
and drive mechanisms.
2. Orient SmartBox® cradle as shown in
Figure 7.
3. Place 5/16” x 3/4” bolt with washer
through cross slot in cradle, through
hole in row unit frame and secure with
lock nut.
4. Using SmartBox® cradle mounting clips
to secure rear of cradle, orient clips
underneath planter row unit frame so
short bend is facing toward center and
upward (as shown).
5. Place 5/16” x 3/4” bolt with washer
through rear hole of cradle down
through planter row unit frame and
SmartBox® cradle mounting clip and
secure with lock nut.
Figure 7

Installation: Cradle - Case IH Planter Model 1200

Figure 7A

1. Remove existing insecticide hoppers
and drive mechanisms.
2. Orient SmartBox® cradle as shown in
Figure 7A.
3. Place 5/16” x 3/4” bolt with washer
through cross slot in cradle, through
hole in row unit frame and secure with
lock nut.
4. Using SmartBox® cradle mounting clips
to secure rear of cradle, orient clips
underneath planter row unit frame so
short bend is facing toward center and
upward (as shown).
5. Place 5/16” x 3/4” bolt with washer
through rear hole of cradle down
through planter row unit frame and
SmartBox® cradle mounting clip and
secure with lock nut.
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Installation: Cradle - White Planter Series 6000

Figure 8

1. Position seed hoppers so that lids
slide toward front of planter
(SmartBox® transfer containers will
interfere with lids sliding toward
rear of planter)
2. Remove existing insecticide
hoppers and drive mechanisms.
3. Orient SmartBox® cradle as
shown in Figure 8.
4. Attach White planter brackets to
rear of row unit frame (as shown)
using 5/16” x 3/4” bolt with washer.
5. Position cradle so that open-ended
slot of cradle slides forward
underneath head of row unit frame
post.
6. Secure cradle to White planter
bracket using double holes on both
sides at rear of cradle using 1/4” x
3/4” bolt and washer with lock nuts.

Installation: Cradle - White Planter Series 6000 Vertical Fold Planter and
Planter with Liquid Fertilizer Tanks Mounted in Front of
Planter Seed boxes - Using White Seal Lid Kits
1. Replace sliding lids on seed hoppers
with lids purchased separately in
White seal lid kits.
2. Repeat steps 2 through 6 above.

Installation: Cradle - White Planter Series 6000 Vertical Fold Planter and
Planter with Liquid Fertilizer Tanks Mounted in Front of
Planter Seed boxes - Using White Seal Lid Kits
1. Remove seed hoppers.
2. Place hopper ring into position and
secure.
3. Insert seed hopper into the ring and
secure.
4. Repeat steps 2 through 6 on the
previous page.
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For easier installation, mount the meter to the base container before installing the base container in the cradle. Install the meter discharge tube onto the meter after the base container is
installed in the cradle. Note: These instructions are for initial meter installation. For meter
replacement, see instructions in Section D of the manual. Always use a new meter gasket when installing or replacing a SmartBox® meter.

Installation: Cradle - Meter to Base Container

Figure 9

Installation: Base Container to Cradle

1. Position the meter with the 45° meter
discharge opening facing forward
(pointing toward the short side of the
base container and pointing toward the
planter tool bar).
2. Ensure the gasket and meter screen are
properly installed on the meter. NOTE:
Always use a new gasket when
replacing or re-installing a meter.
Place a thin layer of silicone caulk
around edge of gasket to seal.
3. Place the 1/4” x 1” bolts up through the
meter, base container flange, and
washer. Lightly secure with the lock
nuts (see Figure 9).
4. Examine meter gasket to make sure it is
centered to provide a good seal.
5. Tighten all bolts securely. Torque all
bolts to 25 – 30 in-lbs. NOTE: Do not
over-tighten or under-tighten bolts;
meter-to-base gasket must be
compressed 60%-75% for proper
sealing. Over-tightening can cause
the meter-to-base gasket to tear.

1. Orient the base container into the
cradle with the shorter sloped end of
the container toward the planter tool
bar.
2. Loosely secure the base container to
the cradle using the 1/4” x 1/2” bolts
with washers. Tighten all bolts
securely.
Figure 10
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Installation: Transfer Container
1. Remove rain cover from base container
(see Figure 12). Store rain cover for use
whenever transfer container is not
installed on base container.
2. Apply a light dusting of baby powder/
talc on the base container seal prior to
seating transfer container. This step
is necessary to avoid damage to the
seals during removal of transfer
container. Do not use a petroleum
based silicon spray to lubricate the
seals. Do not use graphite.
3. Remove the transfer container valve
cover. Store cover for return of used
container to Chemical Dealer.
4. Orient the transfer container so that the
valve handles face away from the planter
seed hopper.
5. Lower the transfer container so each
valve is fully inserted into the mating
base container valve. If valves are not
fully seated, they will not open to
release product to the base container.
6. Clamp transfer container to base
container. Rock each transfer
container from side to side to make
sure that clamps are secure. If the
transfer container is not clamped
securely, the clamps may be made more
Figure 12
secure by increasing the bend in the clamp
arm which hooks onto the transfer container. If your base containers are supplied with
locking pins, insert the pins through the clamps to further secure the transfer containers.
7. Turn valves counter-clockwise 60° to open. If valve does not open smoothly, then the
valve is not seated properly; unclasp container and repeat steps 4 through 6 above. Both
valves must be closed before the transfer container can be removed.

17
Section A

SmartBox® System - System Installation
Section A

Wiring Cables:
Cable routings and extension requirements vary according to the planter manufacturer, fold
style, and number of planter rows. All cables must be routed and secured to the planter in such
a way to eliminate damage during folding or planting. Damage resulting from improper installation will not be covered by the AMVAC Chemical Corporation warranty.
The SmartBox® system includes the following cables (quantities supplied depend
on the planter design):
battery cable
4-row wiring harness
battery extension cable (optional)
8-row wiring harness
12’ hitch cable
15’ meter extension cable
20’ hitch extension cable
lift switch extension cable
(optional)
(optional)
Wiring harness connections are as shown in Figure 13 for a 4-row wiring harness. Suggested
routings are shown in the specific planter arrangement drawings which follow in “Installation:
Wiring Harness, Planter Wiring Instructions”.

Figure 13 - 4-Row Wiring Harness

The battery cable and hitch cable are supplied in the Controller System discussed earlier.
Installation instructions are included in “Installation: Wiring Harness, Tractor Wiring Instructions”.
Use of existing planter seed monitor wiring paths (if equipped) will help to avoid pinch points or
obstructions. Slack should be left in the cables when wiring around hinge points.
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Planter Wiring Instructions

Installation: Wiring Harness

Note: See Appendix A for detailed wiring diagrams on different planters.
1. Position the 1st wiring harness in the center of the rows the harness will service.
2. Run the 20’ 9-pin connection cable on the harness to the tractor-hitch point.
3. If more than one wiring harness is needed, wire the 9-pin connection cable of one harness
to the 9-pin pigtail connector of the other (Do not connect).
4. Run the individual 4-pin cables from the wiring harness to the meters. The row numbers on
the 4-pin cable are for manufacturing purposes only and do not reference to row routing. Do
not connect at this time. Meters and wiring harnesses will be connected during meter configuration.
5. Reposition or add cable extensions (if needed) for proper length.
6. Carefully fold the planter (if not already folded) and check for correct cable lengths and
pinch points.
7. Install and connect the lift switch to the 2-pin connector of the wiring harness.
8. Secure the wiring using the cable ties included starting at each meter. Loop excess wire and
tie to the tool bar.

Tractor Wiring Instructions

Installation: Wiring Harness

1. Connect the 12’ hitch cable to the 9-pin round Deutsch connector in the back of the controller
and run the other end of the hitch cable to the tractor-planter hitch point.
2. If not previously connected, connect the radar unit (if used) to the round 4-pin connector (see
Figure 3).
3. If not previously connected, connect the 12’ power cable from the 2-prong connector of the
controller to the 12-volt battery of the tractor. See instructions for Controller System earlier in
this Section for details. See warnings listed above.
4. Connect the hitch cable to the wiring harness at the tractor-planter hitch point.

Installation Suggestions:
1. Place the planter in the planting position.
2. Layout the wiring harness without tying down the cables.
3. Locate ideal places for wire tying the harness to the planter frame. Do not tie down the cables
at pinch points; this allows the cable to flex during folding. Ideal locations are to follow
existing electrical and hydraulic lines.
4. When attaching the meter cables to the planter, remember that it may be more advantageous
to connect a longer cable to a closer row and a shorter cable to a meter extension cable and
then to the further row.
5. If more than one wiring harness is used, it is usually more convenient to connect the harness
on the left side (from the back of the planter) to the hitch extension cable. This is due to the
massive number of hydraulic and electrical cables threaded through the right side of the
tongue.
6. Secure the harness(es) to the planter by connecting the wire ties.
7. Attach the hitch extension cable to the hitch cable and place the cable along the tongue.
8. Fold the planter to the transport position and then check all of the pinch points to be sure that
the wires stay in place and the connections remain intact.
9. Unfold the planter to the planting position and check all of the pinch points to be sure that the
wires stay in place and the connections remain intact.
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Lift Switch (Whisker) Installation: Locate a protected location on the implement that will
allow the lift switch to contact the implement when the implement is in the lower position.
Mount the lift switch in the “neutral” position when the implement is in the raised position. As
the implement is lowered, the lift switch contact arm should be pushed to the side, turning “on”
the SmartBox® System.
A magnetic mounting bracket is provided, but you may need to fabricate a special bracket,
based on your particular mounting location and configuration. The lift switch mounting should
allow for adjustment of the lift switch to allow for switch activation at different implement
heights.
To obtain maximum magnetic holding force, it is very important that the mounting surface be
smooth and free of dirt, weld splatter, paint runs, etc. It is also important that any debris be
removed from the magnet before mount is made.
Connect the lift switch cable to the 2-pin connector on one of the 4-row or 8-row wiring harness.
On systems using more than one wiring harness, only one lift switch is required and may be connected to the 2-pin connector on any of the harnesses used. The 2-pin connector on any other
harnesses used will remain empty.
Lift Switch (Whisker) Wiring
Normally Open
Black

White

Lift Switch (Whisker)
Normally
Closed

Mounted Lift Switch
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Appendix A
Suggested Wiring Configurations by Planter Type:
The following figures show suggested routings for the SmartBox® hitch cable, hitch cable extensions, row harnesses, and meter extension cables for various planters. Please use the tables
included to locate the drawings pertaining to your planter manufacturer, number of planter rows,
and fold type. These arrangements are presented as suggestions only. Routing of cables and lift
switch placement are left to the discretion of the user. Due to the large number of planter
arrangements available, some planters will not be included in this section. For further information concerning planters not included in this section, please contact your local AMVAC
Representative.
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Manufacturer

Series

Rows

Case IH
Case IH
Case IH
Case IH
Case IH
Case IH
Case IH
Case IH
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
John Deere
Kinze
Kinze
Kinze
Kinze
Kinze
Kinze
Kinze
Kinze
White
White
White
White
White
White
White
White
White
White
White

950
955
950
955
950
950
955
955
1720
1760
1770
1770NT
1780
1790
7000
7000
7100
7200
7200
7300
1770
1770NT
1780
1790
7000
7100
7200
1770
1770NT
1780
1790
7000
7000
7100
7100
7200
7200
DB66
2100
2200
2300
2600
2100
2300
2600
2700
5100
6102
6122
6180
6200
6300
6702
6722
6762
6180
6500

12
12
16
16
24
24
24
24
12
12
12
12
12
12
12
12
12
12
12
12
16
16
16
16
16
16
16
24
24
24
24
24
24
24
24
24
24
36
12
12
12
12
16
16
16
24
12
12
12
12
12
12
12
12
12
16
24
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Planter Drawing
Number

Folds
front,
front,
front,
front,

narrow row
narrow row
narrow row
narrow row
front
narrow front row
front
narrow front row
stack
flex
front, narrow row
front, narrow row
front, narrow row
front, narrow row
flex
front, narrow row
front, narrow row
flex
front, narrow row
stack
front, narrow row
front, narrow row
front, narrow row
front, narrow row
front, narrow row
front, narrow row
front, narrow row
front
front
narrow row front
front
front
narrow row front
front
narrow row front
front
narrow row front
front
stack
flex
front
twin line
stack
front
twin line
front parallel
standard, vertical
standard, vertical
standard, vertical
front
flex
flex
standard, vertical
standard, vertical
standard, vertical
front
front

fold
fold
fold

fold
fold
fold

3, 4
3, 4
19, 20
19, 20
32, 33
34, 35
32, 33
34, 35
9, 10
1, 2
3, 4
5, 6
3, 4
7, 8
1, 2
3, 4
3, 4
1, 2
3, 4
9, 10
19, 20
23, 24
19, 20
21, 22
19, 20
19, 20
19, 20
32, 33
36, 37
34, 35
38, 39
32, 33
34, 35
32, 33
34, 35
32, 33
34, 35
44, 45
9, 10
1, 2
11, 12
13
25, 26
27, 28
29
40, 41
16
16
16
17, 18
14, 15
14, 15
16
16
16
30, 31
42, 43
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Controller Setup
The SmartBox® controller requires several setup steps to produce accurate chemical application.
This section of the Operator’s Manual will show those steps required as a minimum, as well as
additional steps which may be followed to increase the benefits of the SmartBox® system.
One added feature of the SmartBox® system is the ability to upload field and user information
from a personal computer to the controller. Instructions for uploading information are given in
Section C. Instructions provided in this section are for programming directly into the controller.
•

The controller screen will show only four menu choices at a time. To view all of the
selections available in a menu, press the down arrow button repeatedly to scroll through
the selections.

•

To make a selection from the menu, push the up or down arrow button repeatedly until
the arrow on the menu screen points toward your selection. Then push the “ENTER”
button to move into the next level of menu choices.

•

The “RETURN” option is available in each menu. Selecting this option will return the
controller to the previous menu.

•

To return to the original menu during operation, press the “PREVIOUS PAGE” and “NEXT
PAGE” buttons at the same time.

A “map” of controller menus is presented on the next pages. Those steps required for accurate
insecticide application are shaded. Other steps are optional but will greatly enhance operation
and record keeping of the system. Instructions for particular functions (such as inputting user
information, programming A/B switches, and recording weather conditions) are shown following
the controller function map. The instructions are given in an order of probable use, but programming sequence and use of optional functions are at the discretion of the user.
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Controller Functions

Row Configuration

REQUIRED
OPTIONAL

The Row Configuration routine is used to assign row numbers to each of the meters. This
routine is needed at initial system setup or whenever more than one new meter is attached.
Note: If you have previously configured all rows and are replacing only one meter, see
applicable instructions in Section D.
Step 1
From Main Menu select SETUP and
press ENTER.
Step 2
Using the arrow keys, scroll to ROW
CONFIG and press ENTER.
Step 3
Using the arrow keys, select the number
of rows and press ENTER.
Step 4
Disconnect the 4-pin connector from
each meter. Press NEXT PAGE to begin
configuration.
Step 5
Attach the 4-pin connector for the row
which is to be designated as Row 1 and
wait for three “beeps”. The screen will
automatically sequence to the next row.
Step 6
Repeat Step 5 until all rows have been
configured.
End
After all rows have been configured, the
system will automatically advance to the
SETUP menu.
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Planter Configurations

REQUIRED
OPTIONAL

The planter Configuration routine is used to record or change the number of planter rows and
row spacing. This information is required for calculation of acreage values.

Step 1
From Main Menu select SETUP and
press ENTER.
Step 2
Using the arrow keys, scroll to
PLANTER CONFIG and press
ENTER.
Step 3
Using the arrow keys, select NUMBER
OF ROWS and press ENTER.
Step 4
Use the arrow keys to increase or
decrease the value shown until it equals
the number of planter rows (1 to 48).
Press ENTER.
Step 5
Using the arrow keys, select ROW
SPACING and press ENTER.
Step 6
Use the arrow keys to increase or
decrease the value shown until it equals
the planter row spacing in inches (10.0 to
100.0). Press ENTER.
End
Using the arrow keys, select RETURN and
press ENTER to return to the main menu.
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Speed Calibration

REQUIRED
OPTIONAL

The Speed Calibration routine is used to accomplish two objectives: to choose either true or
fixed speed and to calibrate the true speed device if used. “True” speed here indicates use of
either radar or a true wheel speed sensor; a wheel sensor is considered true speed, however
no compensation is made for wheel slippage.
The SmartBox® system will work in either fixed or true speed mode. The meters will compensate for changes in planter speed only when the system is set in the true speed mode.
The in-field calibration described below is critical for accurate speed measurement and
insecticide application. This calibration is separate from calibrations of the radar itself;
you must calibrate the speed device with the SmartBox® controller by performing the
200’ in-field calibration steps stated below. Do not enter the radar calibration number
used for other monitors. If speed calibration is not performed correctly, then the values
recorded for planter speed will produce errors in calculations of acreage treated,
pounds of chemical applied, and pounds of chemical applied per acre. Inaccuracies
resulting from failure to properly calibrate are the responsibility of the user.
The in-field calibration routine should be used at the start of each new season or whenever a
modification is made which could affect the output of the speed sensor. For greater accuracy,
the 200’ in-field test should be run at the expected planting speed. Also, the test should be
repeated two or three times and the average count value entered into the controller.

Step 1
From Main Menu select SETUP and press
ENTER.
Step 2
Using the arrow keys, scroll to SPEED
CALIBRATION and press ENTER.
Step 3
To choose true speed or fixed speed input,
select MODE RADAR..FIXED and press
ENTER. The screen shown on the left
does not indicate the mode in use; to see
which mode is in use, move to next screen
by pressing ENTER.
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Speed Calibration (continued)

Step 4
Use the arrow keys to choose RADAR
(for either radar or true wheel speed
monitor) or FIXED speed. Press
ENTER to advance.
Step 5
If FIXED speed is chosen, use the arrow
keys to change the speed. Press ENTER
to return to the SPEED CALIBRATION
menu.
Step 6
If RADAR is chosen, press ENTER to
return to the SPEED CALIBRATION
menu. If an in-field calibration has
already been done, scroll to RETURN
and press ENTER to return to the
SETUP menu.
Step 7
If an in-field calibration has not been
done, use the arrow keys to scroll to INFIELD CALIB and press ENTER.
Step 8
Measure and mark a linear course of 200
feet.
Step 9
Press either arrow key as you enter the
course. The controller will then measure
the counts of the radar. If your controller
fails to count pulses as you move through
the course, re-start controller and repeat
above steps. If pulses still do not register,
you may need a signal booster for the
radar system. See recommended contacts
in Section A.
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REQUIRED
OPTIONAL

Speed Calibration (continued)

Step 10
Press the opposite arrow key as you exit
the course. The controller will then
calibrate according to the counts of the
radar.
Step 11
Press ENTER to accept the calibration
and return to the SETUP menu. Or, push
either arrow to return to the MEASURE
200 FEET screen to redo the in-field
calibration.
Step 12
To change radar counts per 200 feet
(6096 counts is preset), select
COUNTS / 200 FEET and press
ENTER.
Step 13
Use the arrow keys to change the radar
count value. Press ENTER to the
SPEED CALIBRATION menu. This
step may be done to move the radar
reading slightly to agree with a monitor
already calibrated and correct. Do not use
the value provided in the radar system
owner’s manual or obtained from calibration with a different monitor without
confirming calibration with an in-field
test.
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Speed Calibration (continued)

Step 14
To reduce the count number for certain
wheel sensors, select RADAR DIVIDE
NUM and press ENTER.
Step 15
Using the arrow keys, select a number that
will put the counts under 10,000. Press
ENTER when complete.
End
Select RETURN to go to the SETUP menu.
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REQUIRED
OPTIONAL

AB Control Switch

The AB Control Switch routine is used to select certain meters to be controlled by the A or B
switch. This function is beneficial when planting point rows or planting along the edge of a
field. Those rows which are not needed can be shut off simply by pre-assigning those rows to
the A or B switch, and then flipping the corresponding switch to the off, or down, position.
The simplest way to understand this function is to ask the following question while programming the controller: When the A (or B) switch is off (pushed to the down position), do I want
row 1 (or other row) shut off? If the row is to be shut off, then the answer is “yes”. If the row is
to be on, then the answer is “no”.
Use of this function is optional.

Step 1
From the Main Menu select SETUP.
Step 2
Using the arrow keys, scroll to AB
CONTROL SWITCH and press
ENTER.
Step 3
Using the arrow keys, select YES or NO
for row 1 on the A switch. If YES is
selected, then the meter on row 1 will
shut off when the A switch is flipped to
the down position. Press the “NEXT
PAGE” button to advance to the next
row. Press ENTER to move to the B
switch.
Step 4
Repeat Step 3 for B switch assignments.
Press ENTER to return to the SETUP
menu.
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REQUIRED
OPTIONAL

Controller Adjust

The Controller Adjust routine is used to set date and time, select English or metric units, and
adjust the controller contrast and backlight. The SmartBox® systems are preset with standard
Eastern time and English units.

Step 1
From the Main Menu select SETUP.
Step 2
Using the arrow keys, scroll to
CONTROLLER ADJUST and press
ENTER.
Step 3
Using the arrow keys, scroll to SET
DATE TIME and press ENTER.
Step 4
Using the arrow keys, scroll to the
correct year. Press the “NEXT PAGE”
button to move to the next screen.
Step 5
Using the arrow keys, scroll to the
correct month. Press the “NEXT PAGE”
button to move to the next screen.
Step 6
Using the arrow keys, scroll to the correct
day of the month. Press the “NEXT
PAGE” button to move to the next
screen.
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REQUIRED
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Controller Adjust (continued)

Step 7
Using the arrow keys, scroll to the
correct hour. Press the “NEXT PAGE”
button to move to the next screen.
Step 8
Using the arrow keys, scroll to the
correct minute. Press ENTER to save
settings and return to the
CONTROLLER ADJUST menu.
Step 9
Using the arrow keys, scroll to
ENGLISH METRIC and press
ENTER.
Step 10
Using the arrow keys, scroll to select
either English or metric units of measure.
Press ENTER to return to the
CONTROLLER ADJUST menu.
Step 11
Using the arrow keys, select ADJUST
CONTRAST.
Step 12
Using the arrow keys, scroll to increase
or decrease controller contrast. Press
ENTER to return to the
CONTROLLER ADJUST menu.
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Controller Adjust (continued)

Step 13
Using the arrow keys, select ADJUST
BACKLIGHT.
Step 14
Using the arrow keys, scroll to increase or
decrease controller backlight. Press
ENTER to return to the CONTROLLER
ADJUST menu.
End
Select RETURN to go to the SETUP menu.
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REQUIRED
OPTIONAL

Chemical Information

The Chemical Information routine is used to input a chemical name and EPA registration number. The information input in this location will be displayed and recorded for all of the fields as
one description. If different chemicals are to be used and identified on separate fields, then
the chemical name must be input and stored in the FIELD LOCATION lines.
Step 1
From the Main Menu select SETUP.
Step 2
Using the arrow keys, scroll to
CHEMICAL INFO and press
ENTER.
Step 3
Using the arrow keys, select CHEMICAL
NAME and press ENTER.
Step 4
Use the arrow keys to scroll through the
characters available for each space. ONce
located, enter and move to the following
space by pushing the “PREVIOUS PAGE”
or “NEXT PAGE” buttons. Press ENTER
to return to the CHEMICAL INFO screen.
Step 5
Repeat Steps 3 and 4 above for EPA
REGIS NUMBER.
End
Select RETURN to go to the SETUP menu.
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INSTALLATION OF SMARTBOX® SYSTEM MANAGER
SmartBox® System Manager Setup:
The following steps describe proper installation of the SmartBox® System Manager software on
Windows ‘98 or newer systems.
If installing a new version of SmartBox® System Manager software on a computer with an
older version currently active, first remove the older version.
Before installing the SmartBox® System Manager software, close all programs. Always backup
system files before installing new software. It is recommended to create a restoration point prior
to installing new software.
Step 1
Insert the CD labeled SmartBox® System Manager into the CD drive.
Step 2
If the autorun starts, the following screens will appear:
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SmartBox® System Manager Setup (continued):
Step 2 (continued)
If the autorun does not start, click on Start then select Run.

When the run window opens, click the Browse...button. Select the CD drive the SmartBox
System Manager CD was inserted. Select the Setup file and click open, then click OK from the
Run window.
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Step 2 (continued)
The following screens will follow:

Step 3
Click the Next button.
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SmartBox® System Manager Setup (continued):
Step 4
Click the Install button.

Step 5
The following window will appear:
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SmartBox® System Manager Setup (continued):
Step 6
Click the Finish button.

Step 7
Remove the CD from the drive.
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SmartBox® System Manager
Add a New Controller:
Step 1
Open the SmartBox® System Manager by going to the Start menu, Programs, Amvac Chemical
Corporation, then clicking on SmartBox System Manager.

Step 2
Click on the Controller Information button to add a new controller.
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Add a New Controller (continued):
Step 3
The CONTROLLER INFORMATION screen is displayed.
From the Controller Information screen select the edit menu then choose Add New Controller.
The grower information can now be added.

Select the Model controller. Important: The Model controller must be correct to complete the
data download. The controller will have a model number under the SmartBox® logo.
Model: SBC-2000 = 2004 or Earlier
Model: SBC-2005 = 2005 or Later
In the Controller Name field, type in the name of the Controller. Note that the controller name
is simply the name of the file in which information will be stored or transferred. The controller
name should be kept to 20 characters or less. Do not use punctuation marks or special characters in the controller name.
The Chemical Name, EPA Registration, and Controller Description fields are optional. Enter
information desired.
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Add a New Controller (continued):
Step 4
Click on the Save button to add the Controller. Click the OK button to create the field records.

Step 5
Click the Close button
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Set Current Controller:
Step 1
From the Main Menu, click the Set Current Controller button.

Step 2
Select the controller from the drop-down menu, then click OK.
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Set Current Controller (continued):

End
The controller selected is displayed in the Current Settings section of the Main Menu screen.
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Data Download - 2005 or Later Controllers:
Step 1
From the Main Menu, click on the Transfer Data button..
Note: A current 2005 or later controller must be selected before choosing Transfer Data. See
Set Current Controller.
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Data Download - 2005 or Later Controllers (continued):
Step 2
The SmartBox® Communication Center screen is displayed.

Follow the Instructions that are displayed.
A.
B.
C.
D.

Select the appropriate Communications Port that the Controller will be connected to.
Select the appropriate Controller.
Select the appropriate Operator. (Optional)
Connect the Controller to the COM port selected above on the PC.
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Data Download - 2005 or Later Controllers (continued):
Step 3
Once the Controller is connected, click on the Connect to Unit button. The following screen will
appear:
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Data Download - 2005 or Later Controllers (continued):
Step 4
Use the SmartBox® Controller to initiate the data transfer.
When transferring information from the SmartBox® controller to a personal computer, there are
four options:
1. TRANSFER ONLY - Transfers all stored application data without erasing any information
from the controller to the computer.
2. TRANSFER AND CLEAR - Transfer all stored application data and erases all field data.
User information, such as Field Locations, Chemical Info, and User Info remain in the
controller.
3. ERASE ALL DATA - Does not transfer information, but clears all stored data from the
controller memory.
4. TRANSFER PC INFORMATION - Transfers grower information, operator information, and
field information (field name and address) from the SmartBox® System Manager to the
SmartBox® Controller.
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Data Download - 2005 or Later Controllers (continued):

REQUIRED
OPTIONAL

Step 4 (continued)
Transfer Only Option
Connect the 9-pin RS232 port from the
back of the controller to the computer.
Step 1
From the Main Menu select SETUP.
Step 2
Using the arrow keys, scroll to MEMORY
TRANSFER and press ENTER.
Step 3
To transfer data without clearing it from
memory, select TRANSFER ONLY and
press ENTER.
Step 4
Press ENTER at the READY TO TRANSFER screen.
Step 5
While data is being transferred, the SENDING AREA INFORMATION screen will
appear.
Step 6
When transfer is complete, the TRANSFER IS COMPLETE screen will display
momentarily then advance to the Memory
Transfer Menu.
Step 7
Click the DISCONNECT FROM UNIT button on the SmartBox® Communication
Center.
End
To return to the Setup Menu, select
RETURN and press ENTER.
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Data Download - 2005 or Later Controllers (continued):

REQUIRED
OPTIONAL

Step 4 (continued)
Transfer and Clear Option

Step 1
From the Main Menu select SETUP.
Step 2
Using the arrow keys, scroll to MEMORY
TRANSFER and press ENTER.
Step 3
To transfer data and automatically clear all
field related information while keeping user
and chemical information in memory, select
TRANSFER & CLEAR and press ENTER.
Step 4
Press ENTER and hold for three (3) seconds to confirm transferring and clearing
data. CAUTION: Proceeding will clear
valuable information.
Step 5
Press ENTER at the READY TO TRANSFER screen.
Step 6
Press ENTER to continue.
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Data Download - 2005 or Later Controllers (continued):

REQUIRED
OPTIONAL

Step 4 (continued)
Transfer and Clear Option

Step 7
While data is being transferred and
cleared, the SENDING INFORMATION and
CLEARING DATA screens will appear.
Step 8
The CLEARING DATA screen will automatically advance to the CONNECTED TO
PC RECEIVING USER INFO screen.
Step 9
When transfer is complete, the TRANSFER IS COMPLETE screen will display
momentarily then advance to the Memory
Transfer Menu.
End
To return to the Setup Menu, select
RETURN and press ENTER.
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Download Data - 2005 or Later Controllers (continued):

REQUIRED
OPTIONAL

Step 4 (continued)
Erase All Data Option
Step 1
From the Main Menu select SETUP.
Step 2
Using the arrow keys, scroll to MEMORY
TRANSFER and press ENTER.
Step 3
To transfer data and clear memory, select
ERASE ALL DATA and press ENTER.
Step 4
Press both arrow keys simultaneously and
hold for ten (10) seconds to begin clearing
data. CAUTION: Proceeding will erase all
important user information.
Step 5
While data is being cleared, the CLEARING DATA screen will appear.
Step 6
When completed, the screen will automatically advance to the Memory Transfer
Menu.
End
To return to the Setup Menu, select
RETURN and press ENTER.
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Data Upload - 2005 or Later Controllers:
This option is used to upload information from a SmartBox® System Manager controller file to the
SmartBox® controller. Grower, Operator, and Field information can be entered into a controller
file.
Step 1
From the Main Menu, click on the TRANSFER DATA button.
Note: A current 2005 or later controller must be selected before choosing Transfer Data. See Set
Current Controller.
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Data Upload - 2005 or Later Controllers (continued):
Step 2
The SmartBox® Communication Center screen is displayed.

Follow the Instructions that are displayed.
A.
B.
C.
D.

Select the appropriate Communications Port that the Controller will be connected to.
Select the appropriate Controller.
Select the appropriate Operator. (Optional)
Connect the Controller to the COM port selected above on the PC.
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Data Upload - 2005 or Later Controllers (continued):
Step 3
Once the Controller is connected, click on the Connect to Unit button. The following screen will
appear:
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Data Upload - 2005 or Later Controllers (continued):

REQUIRED
OPTIONAL

Step 4
Use the SmartBox Controller to initiate the data transfer.
Transfer PC Info Option
Connect the 9-pin RS232 port from the
back of the controller to the computer.
Step 1
From the Main Menu select SETUP.
Step 2
Using the arrow keys, scroll to MEMORY
TRANSFER and press ENTER.
Step 3
To transfer data from a personal computer
with SmartBox Program Manager installed,
scroll to TRANSFER PC INFO and press
ENTER.
Step 4
Press ENTER to continue.
Step 5
While data is being transferred CONNECTED TO PC RECEIVING USER INFO
screen will appear. The TRANSFER IS
COMPLETE screen will display momentarily then advance to the Memory Transfer
Menu.
End
To return to the Setup Menu, select
RETURN and press ENTER.
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Clear Growers, Operators, Controllers, Field Log Information, or Database:
Step 1
From the Main Menu, click on the Database menu and select the field to clear.
Note: If multiple controllers are in the SmartBox System Manager, the clear function will clear
all fields, not just the current controller.

Step 2
Click Yes to continue.
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Delete A Controller:
Step 1
From the Main Menu, select the controller you wish to delete and set it to the current controller.
See Set Current Controller.

Step 2
From the Main Menu, click on the Controller Information button.
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Delete A Controller (continued):
Step 3
Select the Edit Menu and select
Delete Current Controller.

Step 4
Click the OK button to proceed. An additional window will pop up. Click Yes to proceed.
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Grower Information
Add A New Grower:
Use this function to enter the Grower’s name, address and applicator’s License Number. This
optional information is used for record keeping and reports.
Step 1
From the Main Menu, click on the Grower Information button.

Step 2
The GROWER INFORMATION screen is displayed.
Select the Edit Menu and select ADD NEW GROWER.
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Add A New Grower (continued):
Step 2 (continued)
Enter the appropriate information in the following fields, as needed:
1. Name - Enter the Grower’s name.
2. Address 1/Address 2/City/State/Zip - Enter the Grower’s address.
3. App. Lic. No. - Enter the Grower’s Applicator License Number.

Step 3
Click the Save button.

End
Click on the Close button to return to the MAIN MENU.
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Update Grower Info:
Use this function to enter corrections to previously entered grower information.
Step 1
From the Main Menu, click on the Grower Information button.

Step 2
The GROWER INFORMATION screen is displayed, click on the Grower to be corrected to highlight it.

28
Section C

SmartBox® System - Computer Setup
Section C

Update Grower Info (continued):
Step 3
From the Grower Information screen select the Edit Menu then choose Update Current
Grower. The grower details can now be changed.

Step 4
Enter the corrections to each field, as needed.
Step 5
Click the Save button to accept the changes.
End
Click the Save button then the Close button to return to the MAIN MENU.
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Delete A Grower:
Use this function to delete a previously entered grower.
Step 1
From the Main Menu, click on the Grower Information button.

Step 2
The GROWER INFORMATION screen is displayed, click on the Grower to be deleted to highlight it.
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Delete A Grower (continued):
Step 3
From the Grower Information screen select the Edit Menu then choose Delete Current
Grower.

Step 4
Click OK to proceed. An additional window will pop up, Click Yes to proceed.

End
Click the Close button to return to the MAIN MENU.
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Print Grower Information Report:
Use this function to print the Grower Info Report.

Step 1
From the Main Menu, click on the Grower Information button.

Step 2
The GROWER INFORMATION screen is displayed.
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Print Grower Information Report (continued):
Step 3
From the Grower Information screen select the File Menu then choose Print Current Grower.
Note: To print the current grower, the grower must be selected (highlighted in yellow).

Step 4
The SmartBox Report Viewer will appear. Click on the print icon at the top of the screen.
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Print Grower Information Report (continued):
Step 5
Click the CLOSE button to close the SmartBox Report Viewer.
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Operator Information
Add A New Operator:
Use this function to enter the Operator’s name, address, and Applicator’s license number.
This optional information is used for record keeping.
Step 1
From the Main Menu, click on the Operator Information button.

Step 2
The OPERATOR INFORMATION screen is displayed.
Select the Edit Menu and select ADD NEW OPERATOR.
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Add A New Operator (continued):
Enter the appropriate information in the following fields, as needed:
1. Name - Enter the Operator’s name.
2. Address 1/Address 2/City/State/Zip - Enter the Operator’s address.
3. App. Lic. No. - Enter the Operator’s Applicator License Number.

Step 3
Click the Save button.

End
Click the Close button to return to the MAIN MENU.
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Update Operator Info:
Use this function to enter corrections to previously entered Operator Information.
Step 1
From the Main Menu, click on the Operator Information button.

Step 2
In the Operator Information screen, click on the Operator to be corrected to highlight it
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Update Operator Info (continued):
Step 3
From the Operator Information Screen select the Edit Menu then choose Update Current
Operator. The Operator Information can now be changed.

Step 4
Enter the corrections to each field, as needed.
Step 5
Click the Save button to accept the changes.
End
Click the Save button then the Close button to return to the MAIN MENU.
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Delete An Operator:
Use this function to delete a previously entered Operator.
Step 1
From the Main Menu, click on the Operator Information button.

Step 2
In the Operator Information screen, click on the Operator to be deleted to highlight it.
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Delete An Operator (continued):
Step 3
Select the Edit Menu then choose Delete Current Operator.

End
Click on the OK button. An additional window will pop up. Click Yes and Close to return to the
MAIN MENU.
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Print Operator Listing:
Use this function to print the Operator.
Step 1
From the Main Menu, click on the Operator Information button.

Step 2
The OPERATOR INFORMATION screen is displayed.
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Print Operator Listing (continued):

Step 3
From the Operator Information screen select the File Menu then choose Print Current
Operator.
Note: To print the current operator, the operator must be selected (highlighted in yellow).

42
Section C

SmartBox® System - Computer Setup
Section C
Print Operator Listing (continued):
Step 4
The SmartBox® Report Viewer will appear. Click on the print icon at the top of the screen.

Step 5
Click the Close button to close the SmartBox® Report Viewer.

43
Section C

SmartBox® System - Computer Setup
Section C

Field Information
Update Field Info:
Use this function to update field information.
Step 1
From the Main Menu, click on the Field Information button.

Step 2
The FIELD INFORMATION screen is displayed. In the Field Listing section, click on the Field
to highlight and select it.
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Update Field Info (continued):
Step 3
From the Field Information screen, select the Edit Menu then choose Update Current Field.
The field information can now be changed.
1. Field Number - Displays the number of the Field chosen.
2. Grower ID - Enter a Grower ID previously entered in the Grower Info function.
3. Description1/Description2 - Displays data transferred from the controller.
4. Crop Type - Enter Crop Type for this Field.
5. LandLord - Enter the landlord for this Field.
6. Total Acres - Enter the total acres in Field.
7. Acres Treated To Date - Displays data transferred from the controller.
8. Field Notes - Enter miscellaneous information about the Field.

Step 4
Click the Save button to accept the changes.
End
Click the Close button to return to the main menu.
NOTE:
1. THE FIELD NUMBER, DESCRIPTION 1, DESCRIPTION 2, AND ACRES TREATED TO
DATE FIELDS DISPLAY INFORMATION DOWNLOADED.
2. THE FIELD NUMBER AND ACRES TREATED TO DATE FIELDS ARE DISPLAY ONLY
AND CAN'T BE CHANGED.
3. THERE ARE 28 CHARACTER SPACES EACH ALLOTTED FOR CROP TYPE AND LAND
LORD.
4. THERE ARE 9 CHARACTERS SPACES ALLOTTED FOR TOTAL ACRES.
5. THERE ARE 128 CHARACTER SPACES ALLOTTED FOR FIELD NOTES.
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Print Field Listing:
Use this function to print the Field Info Report.
Step 1
From the Main Menu, click on the Field Information button.

Step 2
The FIELD INFORMATION screen is displayed.

46
Section C

SmartBox® System - Computer Setup
Section C

Print Field Listing (continued):
Step 3
From the Field information screen select the file menu then choose Print Current Field Info.

Step 4
The SmartBox® Report Viewer will appear. Click on the print icon at the top of the screen.
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Print Field Listing (continued):
Step 5
Click the Close button to close the SmartBox® Report Viewer.
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Report Options
Printing Reports:
Use this function to print reports.
Step 1
From the Main Menu, click on the Report button you wish to print.
1. The Lbs Applied Report (All Fields) button prints the FIELD LOG - LBS APPLIED
REPORT.
2. The Field Report By Grower button prints the FIELD REPORT BY GROWER REPORT.
3. The Accumulated Acres Report button prints the ACCUMULATED ACRES REPORT BY
DATE.
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Printing Reports (continued):
Step 2
The SmartBox® Report Viewer will appear. Click on the print icon at the top of the screen.

Step 3
Click the Close button to close the SmartBox® Report Viewer.
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Pre-Season Checklist
THE FOLLOWING STEPS ARE REQUIRED PRIOR TO THE START OF EACH
SEASON.
In order to operate the SmartBox® system and obtain accurate application of insecticide, the
following steps must be followed prior to the start of each season. In particular, failure to properly calibrate both the speed monitoring equipment and the SmartBox® meters will result in
either over - or under - application of insecticide and incorrect calculation of chemical used,
application rate, and area treated. Such application error resulting from failure to properly calibrate the system will void all claims, either stated or implied, concerning expected accuracy of
the SmartBox® system.
The pre-season checklist below is divided into two sections:
1. System preparation - These steps include routine maintenance, and possible
component upgrades that should be completed prior to each season’s initial
calibrations.
2. System calibration - These steps include items normally conducted at the time of
each season’s initial meter calibration.

System users should plan on attending a training session in late winter to review the steps
involved in meter calibration. Contact your local AMVAC Representative for further information.
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Operation
Once the controller has been setup by inputting the row and the planter configuration, both
meters and speed input have been calibrated, and any additional optional information has
been input for record keeping, then the system is ready to do its job.
The OPERATE mode must be used during application of insecticide. In this mode, the user
can select the field in which to store information, change the insecticide application rate on the
move, and either monitor true planter speed or change the fixed speed setting. The user is
able to see the accumulated acres covered in the field. Also, information concerning functioning or failure of the system will be displayed on the controller and accompanied by auditory signals while in the OPERATE mode.
The SET WEATHER SPECS mode is available to identify weather conditions experienced during planting. The information entered in this mode is stored for record keeping. Use of the
SET WEATHER SPECS mode is optional.
The VARIABLE RATE = OFF MODE is a new option for the SmartBox® controller to read prescription (variable) rates from an external GPS controller. An external GPS controller must be
used with a prescription map to use this option. Contact your local AMVAC representative or
call 888-SMARTBOX for more details.
The final mode available is the MPH..AREA MONITOR mode created to monitor speed and
total acreage for a field in which no insecticide is being applied. In this mode, the controller will
be active without use of the row units. Therefore, it may be used to view tractor speed and
accumulate acreage covered with the planter or with other implements. When using this tool
without the planter (and lift switch), the acre counter may be stopped by moving the main controller switch to the "OFF" position. This feature was added to the SmartBox® system as a
benefit for the users, and its use is not required.
The Field CAL ADJUST option added to the SETUP menu allows the SmartBox® user to fine
tune the system to specific planting conditions. To use this option, a complete set of insecticide boxes (one 50 pound container of insecticide per planter row) must be run completely
through the SmartBox® system. The base containers should be empty when the new set of
insecticide boxes are loaded, then the System should be operated until row alarms sound indicating the base containers have been emptied. Actual acres covered during the run must be
carefully measured and noted. Once the complete load of insecticide has been dispersed, the
actual acres covered may be inputted. This value will be compared with the expected acreage
calculated for the planter (based on rate set, number of rows, and row spacing). This option
may be used to adjust meter calibration by up to 10% of the set rate; adjustment beyond 10%
will require the grower to do a complete meter calibration.
The following routines show the steps required to use each mode. For further information on
controller messages and alarms, see the SmartBox® Troubleshooting Guides included in this
manual.
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Transfer Container
1. Remove rain cover from base container
(see Figure 12). Store rain cover for
use whenever transfer container is not
installed on base container.
2. Apply a light dusting of baby
powder/talc on the base container
seal prior to seating transfer
container. This step is necessary
to avoid damage to the seals during
removal of transfer container. Do not
use a petroleum based silicon spray
to lubricate the seals. Do not use
graphite.
3. Remove the transfer container valve
cover. Store cover for return of used
container to Chemical Dealer.
4. Orient the transfer container so that the
valve handles face away from the
planter seed hopper.
5. Lower the transfer container so each
valve is fully inserted into the mating
base container valve. If valves are not
fully seated, they will not open to
release product to the base container.
6. Clamp transfer container to base
container. Rock each transfer
container from side to side to make
sure that clamps are secure. If the
transfer container is not clamped
securely, the clamps may be made
more secure by increasing the bend in
Figure 12
the clamp arm which hooks onto the
transfer container. If your base
containers are supplied with locking pins, insert the pins through the clamps to further
secure the transfer containers.
7. Turn valves toward off position before trying to open. Turn valves counter-clockwise 60°
to open. If valve does not open smoothly, then the valve is not seated properly; unclasp
container and repeat steps 4 through 6 above. Both valves must be closed before the
transfer container can be removed.

3
Section D

SmartBox® System - Operations
Section D

REQUIRED
OPTIONAL

Meter Calibration

Meter calibration is performed to adjust each meter to release an accurate insecticide rate.
The meter calibration routine must be performed on all meters at the beginning of each season. In addition, any time a replacement meter is installed, that row must be re-configured and
its new meter calibrated. For best results, growers should recalibrate after planting 150
acres and/or when application rates are not accurate.
Pre-calibration Instructions:
1. Persons conducting meter calibrations must insure that proper safety equipment is
used during calibrations.
2. Prior to meter calibration, run each meter in the Operate mode for a minimum of five minutes
with the tractor running. Meters may be run without chemical during the warm-up period.
· To do this in the shop you will need to set the speed mode to fixed, instead of radar
(refer to section D). Then go to operate on the main screen of your controller and set
the controller as you would to plant your crop.
· You will need to trip the lift switch to allow the meters to run.
· This will also test your flow sensors on each meter.
3. Confirm that each base container is full of chemical. To fill, place a loaded transfer
container on each base container and open valves.
4. Confirm that the scale used for weighing the catches is set to weigh grams and placed on
a flat surface located out of the wind for proper measuring.
Preliminary Steps
a. Number calibration bottles to correspond with the number of planter rows.
b. Measure and record the tare (empty) weight of the empty catch bottle or apply tape to the
calibration bottles to make the weight of each bottle match the weight of the heaviest one.
Record the tare weight.
c. Install a catch bottle under each meter discharge opening, matching the bottle number with
the corresponding row number as configured in the controller. Position bottles so that
bottle cap hinges are not damaged during installation. On John Deere planters with row
mount brackets you will need to remove the bottle caps to allow them to fit over the meter
discharge opening.
d. Turn the main toggle switch in the lower left corner of the controller to the ON (up) position.
e. Turn the A and B toggle switches to the ON (up) position.
Step 1
From the Main Menu select SETUP and press ENTER.
Step 2
Using the arrow keys, scroll to METER CALIBRATION and
press ENTER.
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REQUIRED
OPTIONAL

Meter Calibration (continued)

Step 3
The value shown should equal the number of rows on the
planter. The screen will automatically advance.
Step 4
Using the arrow keys, enter the desired calibration distance.
The two options are 500’ or 1,000’. The longer calibration distance, the more accurate the calibration will be.
Step 5
Using the arrow keys, enter the target catch amount corresponding to the desired application rate. The controller will be
preset at 42.5 grams / 500 ft. (corresponding to 3.0 oz. / 1000
ft. of Fortress) but will allow a value between 5.0 to 120.0
grams / 500 ft. See chart below. Press ENTER to continue.

SmartBox® Application Rate Table
Product

Fortress® 5G

Rate

Target Catch Passing Catch Range
(500’)
(500’ cal. distance)

Target Catch
(1,000’)

Passing Catch Range
(1,000’ cal. distance)

3.7 oz/1000 ft

52.5

49.9 - 52.5 grams

105.0

99.8 - 105.0 grams

Aztec 4.67G

3.0 oz/1000 ft

42.6

40.5 - 42.6 grams

85.2

80.9 - 85.2 grams

Force® 3G

4.0 oz/1000 ft

56.8

53.9 - 56.8 grams

N/A

N/A

5.5 oz/1000 ft

78.1

74.2 - 78.1 grams

N/A

N/A

®

Bolster

TM

15G

Step 6
Using the arrow keys, enter the test speed equal to the
expected planting speed. For example, if the expected average planting speed is 5.5 mph, then scroll until the test speed
is set at 5.5 mph. The controller will be preset at 6.0 mph but
will allow a value between 1.0 to 14.0 mph. Press ENTER to
continue.
Step 7
Press ENTER to start catch test.
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REQUIRED
OPTIONAL

Meter Calibration (continued)

Step 8
The TIME REMAINING value that first appears indicates the
seconds required to plant 500 or 1000 feet of a row at the
selected ground speed. The catch test will end automatically
once the TIME REMAINING value has counted down to zero.
Step 9
Catch test completed. Press NEXT PAGE to enter catch
amounts (or press ENTER to start another catch test).
Step 10
Weigh the caught amount for each row (not including the tare
weight). A sample form to record the catch weights and the N
and P number is included at the end of this section. Using
the arrows, enter the caught amount for each row. Press
ENTER to move to the next row. Once a catch amount has
been entered for each row, the controller will automatically
advance to the next screen.
End
If all catch amounts were within 5% of the target weight, then
press ENTER to return to the SETUP mode. If any catch
weight was outside of the 5% calibration variance, press
NEXT and conduct another catch test. To complete another
test catch return to step 4 and repeat.

AMVAC Chemical has provided calibration assistance and in-field calibration programs to
allow you to monitor your application rate. The correct insecticide application rate is the
responsibility of the farmer/operator.
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SmartBox Calibration Record
Farmer:

Date:

Address:

City:

Chemical Dealer:

Calibrated By:

Make and Model of Planter:
MPH - Calibration Speed
oz/1000 ft - Calibration rate
Important: If application speed and application rate differ from calibrated speed and calibrated rate more that +/-10%, then
the system should be recalibrated at desired application speed and application rates.
Used

Product
®
Fortress 5G
®
Aztec 4.67G

Rate
3.7 oz/1000 ft
3.0 oz/1000 ft

Target Catch
(500’)
52.5
42.6

Passing Catch Range
(500’ cal. distance)
49.9 – 52.5 grams
40.5 – 42.6 grams

Target Catch
(1,000’)
105.0
85.2

Passing Catch Range
(1,000’ cal. distance)
99.8 – 105.0 grams
80.9 – 85.2 grams

®

4.0 oz/1000 ft

56.8

53.9 – 56.8 grams

N/A

N/A

5.5 oz/1000 ft

78.1

74.2 – 78.1 grams

N/A

N/A

Force 3G
TM

Bolster

15G

Catch Test 1

Catch Test 2

N/P
Row

Grams

Num

Catch Test 2

N/P
Grams

Num

Catch Test 1

N/P
Grams

Num

Catch Test 2

N/P
Row

1

25

2

26

3

27

4

28

5

29

6

30

7

31

8

32

9

33

10

34

11

35

12

36

13

37

14

38

15

39

16

40

17

41

18

42

19

43

20

44

21

45

22

46

23

47

24

48
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Replacing A Meter:

!!!! NOTICE !!!!
This meter assembly is intended for use only on the SmartBox® Insecticide
Application System and only with products licensed for application using the
SmartBox® system. Any other usage of this meter will result in the following
actions:
1. All warranty for this meter and any other SmartBox® system component
will be voided immediately.
2. User will be in violation of U.S. Patent laws and will be prosecuted to
the fullest extent of the law.

!!!! Always replace the meter gasket !!!!
These instructions must be followed when removing or replacing a used meter:
A.
Safety precautions:
All SmartBox® system maintenance must be performed in strict
compliance with all applicable product safety restrictions and recommendations as stated on the
product label. Persons working with a SmartBox® system either containing or having contained
a product are responsible for obtaining, reading, and following the product manufacturer’s safety
instructions. The following instructions are included in, but are not a complete statement of, the
requirements for use of AMVAC’s Fortress® 5G, a restricted use pesticide. These steps may or
may not be applicable to the use of other products which may be available for use in a
SmartBox® system. For detailed information concerning the safety requirements of any product,
contact the applicable Chemical Dealer or manufacturer’s representative.
1.
Comply with the following personal protective equipment requirements:
a.
long-sleeved shirt
b.
long-legged pants
c.
shoes plus socks
d.
coveralls
e.
waterproof gloves
f.
protective eyewear
g.
organic vapor respirator
2.
Comply with the following user safety recommendations: Wash hands
before eating, drinking, chewing gum, using tobacco or using the toilet.
Remove clothing immediately if pesticide gets inside. Then wash
thoroughly and put on clean clothing.
3.
Comply with all applicable storage and disposal regulations.
B.
Removal of existing meter and / or meter gasket:
1.
Turn off controller.
2.
Unplug meter from wiring harness.
3.
Close transfer container valves and remove transfer container.
4.
Secure rain cover on base container.
5.
Remove the eight bolts attaching the base container to the cradle as shown in
Figure 1.
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Figure 1

6.

Invert the base container and remove the four 1/4” -20x3/4” bolts attaching the
meter to the base container as shown in Figure 2. The 1/4” flat washer shown
in Figure 2 may have been installed on the meter side of the joint as shown in
the original SmartBox® Operator’s Manual.

1/4” -20 LOCK NUT (AP-92)
1/4” FLAT WASHER (BP-40)
1/4”-20 X 3/4 BOLT (EP-31)
GASKET (SBM-002)
OUTLET POINTING FORWARD

Figure 2

7.
8.

9.

C.

Remove the meter from the base container.
Clear any wet product or obstruction from the meter screen and base container.
If meter is to be re-installed, examine and clear any wet product or obstruction
from the meter.
Properly dispose of the used meter gasket. If meter is being replaced, place the
non-functional meter in a sealed plastic bag for return to AMVAC at a later date.
Your AMVAC sales representative will provide instructions on the return
procedures.

Installation of new meter and / or meter gasket:
1.
Install the meter assembly as stated below and in the SmartBox® Operator’s
Manual under “Installation: Meter to Base Container”.
a.
Position the meter with the 45° meter discharge opening facing forward
(pointing toward the short side of the base container and pointing
toward the planter tool bar).
b.
Ensure the gasket (always use a new meter gasket) and meter screen
are properly installed on the meter.
c.
Place the 1/4” x 1” bolts up through the meter, base container flange,
and 1/4” flat washer as shown in Figure 2 above. Lightly secure with
the lock nuts.
d.
Examine meter gasket to make sure it is centered to provide a good
seal.
e.
Tighten all bolts securely. Torque bolts to 25-30 in-lbs. Do not overtighten or under-tighten bolts. NOTE: A 60% to 75% compression
ration is required for the gasket to properly seal.

9
Section D

SmartBox® System - Operations
Section D

2.

3.
4.
5.

Place the base container back on the cradle and replace the eight bolts holding
it into position as stated in the SmartBox® Operator’s Manual under: “Installation:
Base Container to Cradle”.
Replace the transfer container.
Turn on controller. Follow directions on controller screen to configure meter.
Plug meter into wiring harness. Configure and calibrate if a new meter has
been installed. Used meters returned to their original rows do not require reconfiguration or re-calibration.
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REQUIRED
OPTIONAL

Speed Calibration

The Speed Calibration routine is used to accomplish two objectives: to choose either true or
fixed speed and to calibrate the true speed device if used. For further details on Speed
Calibration, refer to Section B of the manual.
The in-field calibration described below is critical for accurate speed measurement and
insecticide application. You must calibrate the speed device with the SmartBox® controller by performing the 200’ in-field calibration steps stated below. Do not enter the
radar calibration number used for other monitors. If speed calibration is not performed
correctly, then the values recorded for planter speed will produce errors in calculations
of acreage treated, pounds of chemical applied, and pounds of chemical applied per
acre. Inaccuracies resulting from failure to properly calibrate are the responsibility of
the user.
Step 1
From the Main Menu select SETUP and
press ENTER.
Step 2
Using the arrow keys, scroll to SPEED
CALIBRATION and press ENTER.
Step 3
To choose true speed or fixed speed input,
select MODE RADAR..FIXED and press
ENTER.
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Speed Calibration (continued)

Step 4
Use the arrow keys to choose RADAR (for
either radar or true wheel speed monitor)
or FIXED speed. Press ENTER to
advance.
Step 5
If FIXED speed is chosen, use the arrow
keys to change the speed. Press ENTER
to return to the SPEED CALIBRATION
menu.
Step 6
If RADAR is chosen, press ENTER to
return to the SPEED CALIBRATION menu.
If an in-field calibration has already been
done, scroll to RETURN and press ENTER
to return to the SETUP menu.
Step 7
If an in-field calibration has not been done,
use the arrow keys to scroll to IN-FIELD
CALIB and press ENTER.
Step 8
Measure and mark a linear course of 200
feet.
Step 9
Press either arrow key as you enter the
course. The controller will then measure
the counts of the radar. If your controller
fails to count pulses as you move through
the course, restart controller and repeat
above steps. If pulses still do not register,
you may need a signal booster for the
radar system. See recommended contacts
in Section A.
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Speed Calibration (continued)

Step 10
Press the opposite arrow key as you exit
the course. The controller will then calibrate according to the counts of the radar.
Step 11
Press ENTER to accept the calibration and
return to the SETUP menu. Or, push
either arrow to return to the MEASURE
200 FEET screen to redo the in-field calibration.
Step 12
To change radar counts per 200 feet (6096
counts is preset), select COUNTS / 200
FEET and press ENTER.
Step 13
Use the arrow keys to change the radar
count value. Press ENTER to the SPEED
CALIBRATION menu. This step may be
done to move the radar reading slightly to
agree with a monitor already calibrated and
correct. Do not use the value provided
in the radar system owner’s manual or
obtained from calibration with a different monitor without confirming calibration with an in-field test.
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REQUIRED
OPTIONAL

Speed Calibration (continued)

Step 14
To reduce the count number for certain
wheel sensors, select RADAR DIVIDE
NUM and press ENTER.
Step 15
Using the arrow keys, select a number that
will put the counts under 10,000. Press
ENTER when complete.
End
Select RETURN to go to the SETUP menu.
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Select Field Number

The OPERATE mode is used during application of insecticide. When ready to apply insecticide, follow the steps in this SELECT FIELD NUMBER routine. Make sure the controller
is showing the field number in which you want to collect and store data. If not, scroll to
find the correct field number, then push the ENTER button to begin dispensing chemical. Verify rate in oz / 1000’ is set correctly. If the system does not dispense, refer to
the Troubleshooting Guide located in Section C.
To return to the main menu during operation, press the “NEXT PAGE” and “PREVIOUS PAGE”
buttons simultaneously.

Step 1
From the Main Menu select OPERATE and
press ENTER.
Step 2
Choose SELECT FIELD # and press
ENTER.
Step 3
Using the arrow keys, enter the field number and press ENTER to begin dispensing
insecticide.
Step 4
The screen shown on the left is the planting
screen displayed when using radar or true
wheel speed. Use the arrow keys to change
the application rate.

Important: If application speed and application rate differ from calibrated speed and calibrated rate more that +/-10%, then the system should be recalibrated at desired application speed
and applicated rates.
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Select Field Number (continued)

Step 5
Press NEXT PAGE, PREVIOUS PAGE, or
ENTER to show date and time.
Step 6
The screen shown on the left is the planting screen displayed when using a fixed
speed. Use the arrow keys to change the
application rate. Press ENTER to move to
the next screen.
Step 7
Use the arrow keys to change the fixed
speed.
Step 8
Press NEXT PAGE, PREVIOUS PAGE, or
ENTER to show date and time.

The following screen will appear every 30 seconds when the screen is operating properly.

If a message other than the “System OK” message is displayed indicating that the system is
not dispensing chemical, then the Troubleshooting Guide located in Section D may be used to
diagnose the cause and make the necessary corrections.
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Field Cal Adjust

As stated previously, this option is used to fine tune the system to specific planting conditions.
To use this option, a complete set of insecticide containers must be run completely though the
SmartBox® system. Actual acres covered during the run must be carefully measured and
noted. Once the complete load of insecticide has been dispensed, the actual acres covered
value may be input. This value will be compared with the expected acreage calculated for the
planter (based on rate set, number of rows, and row spacing), and the system will be adjusted
to compensate for any environmental or field conditions affecting system accuracy.

Step 1
From the Main Menu select SETUP and
press ENTER.
Step 2
Choose FIELD CAL ADJUST and press
ENTER.
Step 3
If actual acreage has been measured while
a complete set of full insecticide boxes
have been run completely through the
SmartBox® system, press ENTER to go on.
Otherwise, do not use this function to
adjust calibration.
Step 4
Use the up and down arrow keys to adjust
the actual acre value. Press ENTER. The
controller will then advance to the SETUP
menu.

17
Section D

SmartBox® System - Operations
Section D

REQUIRED
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On/Off

The On/Off routine is performed to turn individual flow sensors or meters on or off as needed.
This function can be used to shut off individual rows during re-calibration, during troubleshooting of the system, or whenever a row will not be used.
This function may be used in place of the AB programming function. Once a meter or flow
sensor has been turned off, it can only be turned back on by using this routine again.
Should a flow sensor malfunction during planting, this routine may be used to eliminate repeated auditory warnings concerning the meter. Should such a failure occur, however, it should be
corrected as soon as possible to avoid the chance of running out of chemical in the row for
which the flow sensor has been disabled.

Step 1
From the Main Menu select SETUP.
Step 2
Using the arrow keys, scroll to ON/OFF
and press ENTER.
Step 3
Using the arrow keys, scroll to FLOW
SENSOR and press ENTER.
Step 4
Using the arrow keys, select ON or OFF
for the flow sensor on row 1. If OFF is
selected, then the meter on row 1 will still
operate but the flow sensor will be turned
off. Press the “PREVIOUS PAGE” or
“NEXT PAGE” button to move to another
row. Press ENTER to return to the
ON/OFF menu.
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On/Off (continued)

Step 5
Using the arrow keys, scroll to METER and
press ENTER.
Step 6
Using the arrow keys, select ON or OFF
for the meter on row 1. If OFF is selected,
then the meter on row 1 will not operate.
Press the “PREVIOUS PAGE” or “NEXT
PAGE” button to move to another row.
Press ENTER to return to the ON/OFF
menu.
End
Select RETURN to go to the SETUP menu.
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Set Weather Specs

Step 1
From Main Menu select SET WEATHER
SPECS and press ENTER.
Step 2
Using the arrow keys, scroll to CLOUD
CONDITIONS and press ENTER.
Step 3
Use the arrow keys to find the applicable
condition. Press ENTER to select the condition and return to the SET WEATHER
SPECS menu. The condition selected will
be stored for record keeping.
Step 4
Repeat Steps 2 and 3 for WIND DIRECTION, WIND SPEED AND TEMPERATURE.
Step 5
Press RETURN to return to the Main
Menu.
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AB Control Switch

The AB Control Switch routine is used to select certain meters to be controlled by the A or B
switch. This function is beneficial when planting point rows or planting along the edge of a
field. Those rows which are not needed can be shut off simply by pre-assigning those rows to
the A or B switch, and then flipping the corresponding switch to the off, or down, position.
The simplest way to understand this function is to ask the following question while programming the controller: When the A (or B) switch is off (pushed to the down position), do I want
row 1 (or other row) shut off? If the row is to be shut off, then the answer is "yes". If the row
is to be on, then the answer is "no".
Use of this function is optional.

Step 1
From the Main Menu select SETUP.
Step 2
Using the arrow keys, scroll to AB CONTROL SWITCH and press ENTER.
Step 3
Using the arrow keys, select YES or NO
for row 1 on the A switch. If YES is selected, then the meter on row 1 will shut off
when the A switch is flipped to the down
position. Press the "NEXT PAGE" button
to advance to the next row. Press ENTER
to move to the B switch.
Step 4
Repeat Step 3 for B switch assignments.
Press ENTER and return to the SETUP
menu.
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Area Information

Step 1
From the Main Menu select OPERATE and
press ENTER.
Step 2
Choose AREA INFORMATION and press
ENTER.
Step 3
Use the arrow keys to scroll through the
fields to view areas accumulated in each.
Step 4
To reset the acres to 0.0, press and hold
ENTER for 3 seconds.
Step 5
Press NEXT PAGE to move to the next
screen.
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Area Information (continued)

Step 6
This acreage accumulator may be reset a
any time to keep track of acres planted
during any period. Press NEXT PAGE to
move to the next screen and repeat for
Total Areas Steps 2 through 4. These
accumulated values will be stored for
record keeping. Press NEXT PAGE to
return to the OPERATE menu.
Step 7
Select RETURN and press ENTER to
return to the Main Menu, or choose
SELECT FIELD # to continue planting.
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Variable Rate

The Variable Rate option is used when operating an external GPS controller. The GPS controller can send prescribed application rates to the SmartBox® controller for variable rates
across the field. Typically, the Variable Rate will be disabled (off) for standard planting conditions. The Variable Rate should be enabled if you are using an external GPS controller and
sending prescribed application rates to the SmartBox® controller.

Step 1
From the Main Menu select VARIABLE
RATE = OFF and press ENTER.
Step 2
Use the arrow keys to select either “DISABLED” or “ENABLED” mode.
Step 3
To return to the Main Menu, press ENTER.
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MPH..Area Monitor

The MPH..Area Monitor routine is used to monitor speed and acreage when not applying
insecticide. This function may be used with the lift switch (active) or without the lift switch
(inactive). In the inactive mode, acreage accumulation is stopped by moving the main meter
switch to the OFF position. Although the controller will show the speed and accumulated acres
while in this mode, the information will not be stored for record keeping or printout.

Step 1
From the Main Menu select MPH..AREA
MONITOR and press ENTER.
Step 2
Set the implement width using the arrow
keys and press ENTER.
Step 3
Use the arrow keys to select either
"ACTIVE" or INACTIVE" mode.
Step 4
To reset the area, press ENTER and hold
for 3 seconds. The screen will automatically advance if the area is not reset.
Step 5
To Return to the Main Menu, press PREVIOUS PAGE AND NEXT PAGE simultaneously.
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The Employees of

would like to thank you for purchasing the
SmartBox® System. We are proud of our quality and
believe this product will exceed your expectations!

For More Information Contact:

AMVAC Chemical Corporation
2110 Davie Avenue
Commerce, CA 90040
1-888-SMARTBOX
(1-888-762-7826)
www.amvac-chemical.com
www.smartboxsystem.com
L-26078
3/06

SmartBox® is a registered trademark of AMVAC Chemical Corp.

